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Attachment G

ACCESSING THE FCC NETWORK
USING WINDOWS 3.1 OR 3.11

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 3.1 or Windows for Workgroups 3.11 operating system.  This involves using
the FCC-supplied Point-to-Point Protocol (PPP) Dialer.  

This attachment summarizes the hardware and software required for the PPP Dialer, then
describes the procedures for performing the following tasks:

C Downloading the Dialer files from the Internet or the FCC Bulletin Board
C Extracting the Dialer from the downloaded files
C Installing the Dialer application
C Configuring PPP
C Establishing a PPP connection

The attachment also describes how to troubleshoot and uninstall the PPP Dialer application, and
tells how to get help from the FCC.

Conventions

The instructions in this attachment use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Licensee Name field, Applicant
Information area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://www.fcc.gov, you should type all
of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).
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Hardware and Software Requirements

Applicants who want to connect to the FCC Network using the FCC PPP Dialer will need the
following hardware and software.

Hardware Requirements

C CPU:  Intel 80486 or above

C RAM:  8 MB RAM (more recommended if you intend to open multiple applications)

C Hard Disk:   10 MB available disk space

C Modem:  v.32bis 14.4-kbps Hayes compatible modem

C Monitor:  VGA or above

C Mouse or other pointing device

Software Requirements

C Internet Web Browser software (Netscape Navigator 3.0.1 and Microsoft Internet
Explorer 3.02 with the file upload add-on were used during testing)

C Microsoft Windows 3.1 or Microsoft Windows for Workgroups 3.11

Note:  If you are running Windows in a networked environment, check with your local network
administrator for any potential conflicts with the FCC PPP Dialer.  This usually includes any
TCP/IP installed network protocol.  

The FCC PPP Dialer will establish a point-to-point connection from your PC to the FCC
Network.  This point-to-point connection is not routed through the Internet.

Downloading the Dialer Software

Applicants who wish to use the FCC PPP Dialer must first download the dialer software from
either the Internet or the FCC Bulletin Board System.  Applicants must download the following
compressed files to install the software:

fccdial1.exe
fccdial2.exe
fccdial3.exe
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Download Method 1:  Internet Access

You may use your Internet browser to download the compressed files from www.fcc.gov or
wtbwww01.fcc.gov, as described in the following sections.

C Downloading from www.fcc.gov

1. Connect to your Internet Service Provider and start your web browser.

2. In the Location (Netscape) or Address (Internet Explorer) field of the web
browser screen, enter the following location: http://www.fcc.gov.  Then press the
ENTER key.

3. Click the Electronic Filing link.

4. Click Universal Licensing System at the bottom of the screen.

5. Click the FCC PPP Dialer button, located on the left side of the page.

6. Scroll down to the Download the Dialer section of the page.  Download the
following files by clicking their respective filename links:  fccdial1.exe,
fccdial2.exe, fccdial3.exe 

C Downloading from wtbwww01.fcc.gov

1. Connect to your Internet Service Provider and start your web browser.

2. In the Location (Netscape) or Address (Internet Explorer) field of the web
browser screen, enter the following location:  http://wtbwww01.fcc.gov.  Then
press the ENTER key.

3. Click the Dialer link.

4. Download the following files by clicking each of the corresponding icons: 
fccdial1.exe, fccdial2.exe, fccdial3.exe  

Download Method 2:  Dial-In Access to the FCC Auction Bulletin Board System (BBS)

The FCC Auction Bulletin Board System (BBS) provides dial-in access for the FCC PPP Dialer. 
To access the FCC Auction BBS, use a communications package that can handle at least
Xmodem protocol (such as PcAnyWhere, Procomm, or Microsoft Terminal in Windows 3.x) to
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dial in to (202) 682-5851.  Use the settings of 8 data bits, no parity, and 1 stop bit (8,N,1).

Once your computer is connected to the Auction BBS, do the following:

1. To create an account:

a. Enter your first name.

b. Enter your last name.

c. When asked whether you want to create an account, enter Y.

d. When prompted, enter a password.

The password can be from four to ten characters long, where the characters can be
either letters or numbers.

e. To confirm the password, enter it again.

f. When prompted for contact information, enter your voice phone number, including
area code.  

For example, you might enter 202-555-1234.

g. Enter your company name.

2. On the Welcome screen, enter C for Continue.  (You may also enter c, the program
accepts either uppercase or lowercase.)

Since C is the default (automatic) selection, you can also just press ENTER to continue.

3. When asked whether you want to view the bulletin menu, enter Y for Yes.  Then press
ENTER to obtain the FCC Auction BBS Main Menu.

4. Enter A (for Auction Menu) to obtain the Auction Library Menu.  

The top options on this menu provide a range of numbers to represent the available
auctions.

5. To select Dialer, enter D. 

The list of available files appears.  These files are sorted by date, with the most recent files
at the beginning of the list.
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6. To scroll downward to the next screen of file names, either press ENTER or enter C for
Continue.  To scroll upward to the preceding screen of file names, enter P for Previous.

Note that on each screen, file names are numbered separately, starting with 1.

7. To select one or more files for downloading or viewing, mark the files you want.  The
program marks a file by preceding its name with an asterisk (*).

You can do the following:

C To mark an individual file, enter its line number.  

C To mark a range of files, enter M (for Mark) and then enter the range of files in
response to the prompt.  

For example, to mark files 1 through 3, enter 1-3 at the prompt.

C To unmark a file, enter its number again.  

You can also use Mark to unmark a range of files.

Use any of these techniques to mark the following files:  fccdial1.exe, fccdial2.exe,
fccdial3.exe 

8. When you have finished marking files, download them as follows:

a. Enter D for Download.

The program displays a list that summarizes the download operation.  The Time
column lists the download time for each file; the Total Time column lists a running
total of the download times.

b. Enter D to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation
software (e.g., Xmodem or Zmodem).

When the download operation has finished, the list of files reappears.

9. Enter X to leave the BBS.
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Extracting the FCC PPP Dialer

The FCC PPP Dialer files are downloaded in a self-extracting, compressed file format.  When you
have downloaded the compressed files, you must extract the FCC PPP Dialer from each file.  

To extract the software, start File Manager in the Main Program group, open the file folder where
you downloaded the files, and double-click each file (fccdial1.exe, fccdial2.exe, fccdial3.exe).  A
message will appear listing the default directory to which the software will extract.  If this
directory does not exist, it will be created automatically.  Click Unzip to begin extracting the
software from the compressed files.

When the extraction is complete, a message will appear listing the number of files that were
unzipped.  Click OK to automatically start the setup program.     

Installing the FCC PPP Dialer

After you extract the software from all of the compressed files, go to File Manager, locate the
directory to which you extracted the software, and double-click setup.exe.

To begin, the setup program shows a screen listing the default directory to which the software
will install.  Click the Install button, then click OK to install to the specified directory.  If the
directory does not exist, the setup program will create it automatically.   

When the installation is complete, a message may appear asking you to restart Windows so that
the changes made by the installation can take effect.  Click Restart to restart Windows or click
Stay Here to restart at a later time.  Do not use the FCC PPP Dialer until you have restarted
Windows.

You will now have a new Program Manager group called FCC PPP Dialer with icons labeled
Configure PPP, PPP Dialer, and Uninstall.

Running the Configure PPP Program

Before establishing a PPP connection, you must run the Configure PPP program.  If desired, you
may also adjust the configuration settings.

To start the Configure PPP program:

1. Double-click the Configure PPP icon.  The communications setup window appears.

2. From the Modem menu, select the COM port to which your modem is connected. 
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3. From the Speed menu, select the maximum DTE rate of your modem.

For 14.4-kbps and 28.8-kbps modems, you can generally select a speed of 38400 or
57600. 

4. In most cases, carrier detect should not be checked and flow control should be checked. 
If you experience problems getting the modem to respond, experimenting with these
settings may help.

5. The DNS should be set to 192.104.54.1.

The remainder of the screen has default values which should provide optimal performance.

6. Click the Script button to bring up the Script Setup screen.  This screen gives you the
ability to issue specific commands to the modem.

7. Click the down arrow in the Selected Modem field and choose the entry from the list that
most closely matches the modem installed on your PC.

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String box.

8. It may be necessary to change the command in the Modem Dial Prefix field to
accommodate how you make calls. 

For example:

No dialing prefix used: ATDT
Dialing prefix of 9 used: ATDT9
Dialing prefix of 9 used, add a 1 before dialing the 800 number: ATDT91
Turn off call waiting, add a 1 before dialing the 800 number: ATDT*70,1

9. If you use a dialing suffix, enter it in the Dial Suffix field.

10. The default settings provided in Configure PPP should be compatible with most systems. 
If you experience problems connecting to the FCC Network, refer to the Troubleshooting
section for possible solutions.

11. When you have finished using the Configure PPP program, click the OK button.  You
may now start the FCC PPP Dialer. 
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Establishing a PPP Connection

Once you have run the Configure PPP program, you can establish a PPP connection.  Do the
following:

1. To start the PPP Dialer, double-click the PPP Dialer icon in the FCC PPP Dialer program
group. 

The dialer will attempt to dial the toll-free 800 number automatically.

2. When the PPP Dialer establishes a connection, you will gain access to the PPP Dial Up
screen.  You may switch to the PPP Dial Up screen by pressing CTRL+ESC and
double-clicking PPP Dial Up in the Task List.

The screen will display the current status of the PPP connection.

3. To refresh the status of the PPP connection, select the Refresh Status option from the Dial
menu.

4. Select the Minimize option from the Window menu to minimize the PPP Dial Up screen.

5. To test the status of the PPP connection, select the Test Connection from the Dial menu. 
This option allows you to ping the FCC Network.  The ping process sends a signal to the
FCC Network; if the signal returns, you have established a good connection.

The Hostname box will show 192.104.54.1.

6. From the Number menu, choose the number of pings you wish to send (one, continuous,
or a user-specified number).  From the Specifications menu, you can customize the type of
request (e.g., icmp echo request), the interval between pings, and the timeout setting; the
default settings should suffice.  

If you change any of the settings and would like to save them, select the Save option from
the File menu.

7. Click the Start button.  

The status and packets boxes will display information concerning whether the pings were
returned.  

8. If necessary, click the Stop button, to end the ping process.  Click the Exit button to exit
the Ping program.
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Disconnecting the PPP Connection

To disconnect from the FCC Network, switch to the PPP Dial Up screen and select the
Disconnect option from the Dial menu.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond

1. Check the COM port setting.

2. Make sure that you have selected the appropriate modem in the Selected Modem list.  

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String field.

3. Check your modem for IRQ conflicts.

4. Check the physical connections.

5. Change Carrier Detect.

6. Change Flow Control.

Modem connects but does not return an IP address

1. Check that you have selected the appropriate modem in the Selected Modem list.

2. Verify the DNS is set to 192.104.54.1.

3. Verify the MRU and MTU are set to 1500.

4. Turn off VJ Compression.

5. Change timeout to 15.

This is found on the Script Setup screen in Configure PPP.
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6. Check your modem for IRQ conflicts.

7. Unload network drivers.

SQLSERVER errors

1. Turn off VJ Compression.

2. Unload network drivers.

3. Check for the existence of multiple winsock.dll files on your PC.

4. Test the PPP connection with the Ping program.

Errors may be caused by having multiple winsock.dll files on your PC.  To search for conflicting
winsock.dll files, start File Manager, open the directory for the root of the hard drive you want to
search (usually c:\) and select the Search option from the File menu.  In the search for: box, enter
winsock.dll.  Verify that the select all subdirectories option is selected, then click OK.

Make sure that any other winsock files are not in your path.  To check this, go to the DOS
prompt and type path.  If any directory containing another winsock.dll file appears in the path, do
either of the following:

C Edit the autoexec.bat file to remove the reference to that directory, then save and reboot
the PC.  If you need to use the other PPP software package, reinsert the appropriate
directory reference, save, and reboot.

C Temporarily rename the conflicting winsock.  

Uninstalling the FCC PPP Dialer Application

To uninstall the FCC PPP Dialer, double-click the Uninstall icon in the FCC PPP Dialer program
group.  Click Start to uninstall the software.

Technical Support

For technical assistance in installing or using the FCC PPP Dialer, contact the FCC Technical
Support Hotline at (202) 414-1250.  This hotline is generally available Monday through Friday,
from 8 a.m. to 6 p.m. ET.  All calls to the FCC Technical Support Hotline are recorded.


